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1.1 ABOUT 

ArCADia-SEWAGE INSTALLATIONS is a tool that extends the functionalities of ArCADia-INTELLICAD, 

AutoCAD and ArCADia-START with features that allow quick creation of drawings of indoor sewage 

installations on blueprints and creating supplementary drawings: drain pipeline profiles and 

extensions of sewage stacks and drain pipes. The software is meant for designers of indoor sanitary 

installations.  

The software takes into consideration the different types of sanitary installations in the building: 

sanitary sewage installations, rainwater sewage systems (draining rainwater from the roofs by means 

of indoor drain pipes) and a process waste water sewage system. 

An additional feature of the software that results from the capabilities of the system into which it 

was incorporated is defining intersections and crossovers with other items present in the building, as 

well as with other architectural items of the building.  

1.2 FEATURES AND POSSIBILITIES OF THE PROGRAM 

Technical scope of the software and its basic features: 

 Providing characteristic information for sanitary waste water and rainwater recipients. 

 Defining branch lines for devices receiving waste water and rainwater. 

 Determining the location of sewage stacks and drain pipes in all the projections (levels). 

 Determining branch lines for recipients. 

 Determining the route of underfloor and ceiling sewage pipelines, connection sites of 

pipelines and the method of executing connections. 

 Calculating the section flow, fill and velocity. 

 Determining the diameters of sewage sections, drain stacks, drain pipes and slopes. 

 Creating underfloor pipeline profiles with intersections marked. 

 Creating drawings of extensions of sewage stacks and drain pipes. 

 Verifying the validity of the designed sanitary installation. 

 Generating calculation reports. 

 Automatically generating a legend of the symbols used in the project. 

 Generating schedules of quantities for the materials used in the project. 

 Transferring materials used for the creation of the sanitary installation along with the fittings 

to software used for preparing schedules of values, such as Ceninwest or Norma. 

1.3 REFERENCES 

1 Jarosław Chudzicki, Stanisław Sosnowski „Instalacje kanalizacyjne. Projektowanie, wykonanie, 

eksploatacja” Wydawnictwo „Seidel-Przywecki” Sp. z o.o. , Warsaw 2009. 

Catalogues: 

1 Gamrat, Pipe systems – Technical catalogue (valid from 01.06.2012), fifth issue 2012/2013 

2 Geberit, Own catalogue prepared on 29.03.2013 www.geberit.pl  
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3 Karmat eco sanitary systems – "White plumbing" catalogue www.karmat.pl 

4 Karmat eco sanitary systems – "Backwater vales, end flap valves" catalogue www.karmat.pl 

5 Karmat eco sanitary systems – "Indoor plumbing" catalogue www.karmat.pl 

6 Steinzeug Keramo – "Technical parameters of glazed vitrified clay products" September 2008 

7 Kessel Sp. z o.o. – Product catalogue 03/2010 "Anti-flooding devices, inside drains, basement 

drain, line drains", www.kessel.pl  

8 Magna plast – "HT plus low-noise indoor plumbing – Installation manual", 

www.magnaplast.pl  

9 Magna plast – "Skolan-dB – thick-walled low-noise plumbing", www.magnaplast.pl 

10 Wavin – "Sewage wells – Product catalogue. For sewage and sewage systems and for 

municipal and industrial applications". April 2011, www.wavin.pl  

11 Wavin – "Wavin QuickStream siphonic roof sewage system" – Product catalogue. For sewage 

and sewage systems and for municipal and industrial applications". June 2011, 

www.waving.pl  

12 Wavin – "Indoor plumbing system – Product catalogue. For standard and low-noise 

blackwater, hot industrial waste water and polluted waste water sewage" January 2013, 

www.wavin.pl  

13 AVK Armadan Price list Sewage fittings and accessories , www.avk.com.pl/cenniki.php 

14 OSMOSE "Traditional vitrified clay in modern technology applications" – Product catalogue 

15 Koneckie Zakłady Odlewnicze S.A. in Końskie, "Sewage cast iron" www.kzo.pl 

16 Sewage manholes – DIAMIR “Reliable sewage network and sewage items”, 

www.kaczmarek2.pl 
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2 INSTALLING AND RUNNING THE PROGRAM 
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2.1 HARDWARE REQUIREMENTS 

 Pentium IV PC (PIV D recommended) 

 2 GB RAM (4 GB recommended) 

 Approximately 1GB of free HDD space for the installation 

 DirectX 9.0 compatible graphics card 

 Windows Vista 32/64-bit OS, Windows 7 32/64-bit or Windows 8 32/64-bit 

 DVD-ROM drive 

2.2 INSTALLING 

The program installation is started automatically when the CD is inserted into the CD drive.  

The installation should be started manually if the Autostart function is disabled. Open the CD content 

(Computer/CD drive), and run the Setup.exe file from the program folder. Once the installation is 

started, proceed according to instructions displayed on the screen. 

2.3 RUNNING 

The ArCADia software: 

The software may be started by double-clicking on the ArCADia-START program icon located 

on the Desktop and then selecting one of the icons on the ribbon in the sewage tab. 

 

AutoCAD or ArCADia-INTELLICAD software: 

The software may be started by double-clicking on the CAD program icon located on the 

Desktop and then selecting one of the icons in the ArCADia-SEWAGE INSTALLATIONS 

toolbar. 

2.4 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 

 A standard DWG drawing file.  

 Any of the following sample drawings supplied with the ArCADia-START or ArCADia-

INTELLICAD software may be used. 

 A DXF drawing exchange file. 

 A DWF network transmission file. 

 A DWT drawing template file.  

In order to quickly access the last edited drawing choose File > <file name>. The software stores the 

names of the last four drawings. In order to quickly access a drawing from the Open drawing 

dialogue box, double-click the drawing name. 
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A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. 

All you need to do to open the drawing in ArCADia-START or ArCADia-INTELLICAD is to double-click 

the file. Miniature drawings displayed when browsing facilitate the identification of the selected 

drawing. 

Opening an existing drawing 

The ArCADia software: 

Use one of the following methods: 

o Choose the Home ribbon and then in the Files logical group choose the Open button. 

o Press the  button and then press the Open button 

 

AutoCAD or ArCADia-INTELLICAD software: 

Use one of the following methods: 

o Choose File>Open. 

o On the Standard toolbar select the Open  tool. 

o Write open and then press Enter. 

 

Common for ArCADia, AutoCAD and ArCADia-INTELLICAD software 

1. Choose the type of the file you want to open from the file type. 

2. Choose the folder that contains the selected drawing. 

3. Do one of the following: 

o Choose the drawing that you want to open and click Open. 

o Double-click the drawing you want to open. 

If the drawing requires a password, provide the password, click OK to verify the password and then 
click Open again. 

2.5 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing use one of the following methods: 

 

The ArCADia software: 

 Choose the Home ribbon and then in the Files logical group select the button Save. Press the 

ArCADia button and then the Save button. 

 

AutoCAD or ArCADia-INTELLICAD software: 

 On the Standard toolbar click Save. 

 Choose File>Save. 
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 Write save and then press Enter. 

 Write qsave and then press Enter. 

When you save a particular drawing for the first time, the system will display a dialogue box Save 

drawing as, which enables you to select the folder and provide the name for the drawing. You can 

use any name at all when saving the drawing for the first time. In order to save the same drawing 

under a different name later, select File>Save as and then type in the new name. 

2.6 AUTOSAVE AND BACK-UP COPY 

In order to avoid data loss in case of a power outage or another system error, it is necessary to save 

your drawing files often. The software may be configured to periodically save your drawings 

automatically. The Autosave setting determines the interval in minutes between automatic saves. 

The software resets this interval each time the user saves a drawing file (feature available in 

ArCADia-INTELLICAD and AutoCAD). 

When the Autosave feature is activated, the software creates copies of the drawing. This file is 

automatically saved to the folder provide under Options>Paths/Files>Temporary file and particular 

the extension indicated in the Drawing autosave file extension (SV$ by default). 

Configuring ArCADia-INTELLICAD to automatically save drawings 

1. Do one of the following: 

o Select Tools>Options. 

o Write config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to turn the Autosave feature on and 

select the autosave frequency. 

4. Click OK. 
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3 WORKING WITH THE SOFTWARE 
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3.1 BASIC INFORMATION ABOUT THE SOFTWARE 

ArCADia-SEWAGE INSTALLATIONS enables designing sanitary sewage pipelines, rainwater sewage 

pipelines (draining rainwater from the roofs of buildings) and process waste water sewage. The user 

may design a sewage installation based on the type of waste water drained: grey and blackwater, 

rainwater from the roof (for drain pipes located in the building or when its necessary to route the 

outlet pipes under the building’s floor surfacing) and industrial and process waste water (e.g. 

containing grease). The user also has the possibility to select materials that are necessary to build 

pipelines and other items of the installation. 

Projection drawings may be created on blueprints in the format of raster or vector files. At the 

beginning the user determines the location of stacks for a group of recipients with the option to 

define offsets (penetrations under ceilings, stack ventilation method, stack connections). To do that 

it is necessary to input the thickness of the ceilings, level height (during work on blueprints created in 

the ArCADia-ARCHITECTURE software the building geometry data will be generated automatically). 

The software also enables defining casing pipes going through a ceiling and fire penetrations. 

In the subsequent stages of the design process it is necessary to determine characteristic parameters 

for all the sewage recipients, i.e. the design sewage factors (which depend on selecting the system 

for the sanitary installation) and minimum sewage diameters. 

In case of a rainwater and industrial waste water sewage installation the drained volumes will be 

entered by the user based on the discharge parameters of the process equipment. 

The user may design a connection between the devices and the stack and based on that connection 

define the hydraulic loads, which will in turn enable determining the stack diameter. 

The next step is to draw the route of underfloor sewage pipelines in the projections. In order to 

graphically differentiate the pipelines the user may employ different line formats. When drawing a 

sewage section the flow volume is calculated based on the number of devices discharging waste 

water to the particular section. The user may define the manner of connecting the sections (three-

way fitting accounting for the connection angle, connection well). 

The software enables defining items in horizontal sections (cleanouts, inspection openings, wells, 

separators, storm flaps and backdrops). 

Based on the pre-determined slopes, diameters and the data on strip footing and other facilities in 

the network, the software will generate a longitudinal profile of the installation. It is possible to 

define additional parameters in a generated profile, i.e. pipe slope or diameter, which will be 

included in the general sewage model. 

A stack extension will be generated based on the information about the number of devices 

connected to a stack and the sewage system. It will be possible to introduce certain modifications 

(especially to modify the sequence of connections). 

Once the calculations are carried out and diameters are selected, the designer may introduce 

additional corrections and repeat the calculations. Should the designer make an error, the software 

will automatically generate a warning and provide limit parameters. 
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After the entire sewage installation is designed and the project validity is verified, the user may 

generate a calculation report along with a material list. 

The report casings hydraulic calculations for stacks and outlet sections. The entire pipeline and all the 

items along with the characteristic parameters are included in the material lists. 

3.2 SOFTWARE ITEM DESCRIPTION 

Features of the ArCADia-START toolbar for AutoCAD or ArCADia-INTELLICAD (column I) and the 

ArCADia (column II) ribbons: 

 

(Drop-down buttons) includes more than one command 

 The ArCADia-SEWAGE INSTALLATIONS tool ribbon (ArCADia software) 

 

 ArCADia-SEWAGE INSTALLATIONS toolbar 
(AutoCAD or ArCADia-INTELLICAD software) 

Tab. 1. Functions of the ArCADia-SEWAGE INSTALLATIONS toolbar 

I II Option Description 

  

Show/Hide Project 
Manager 

Displays or hides the level management window. 
This feature is available in the View tab in the 
Show/Hide logical group 

 
 

Show options 
Enables settings the basic drawing options. This 
feature is available in the Home tab in the Modules 
logical group,  

  

Insert outflow point for a 
sewage line 

Enables defining the waste water outflow site, type of 
sewage line based on the type of waste water and the 
relative drain location altitude.  

  

Insert internal sewage 
pipe* 

Inserts a pipeline section with the option to determine 
relative altitudes and determine the function for the 
pipeline. 

  

Insert internal sewage 
pipe with a continuous 
route 

Inserts a set of sewage pipes with descriptions 

  

Insert vertical internal 
sewage pipe 

Enables inserting a vertical pipe section with a 
particular function (defining a stack) and defining the 
parameters 
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Insert connection and 
inspection well 

Inserts the connection well item with a description 
and parameters 

  
Insert outflow point for a 
sanitary fixture 

Defines the sewage outflow from a sanitary fixture 
into the sewage installation pipes, especially the 
location, installation height, diameter. 

  
Insert outlet pipeline 
fitting 

Inserts stop and shut-off fittings (e.g. backwater valve) 
along with a description, parameters and housing 

  Insert cleanout 
Inserts the cleanout item along with a description and 
parameters 

  
Insert inspection 
opening 

Inserts an inspection opening along with description, 
parameters and housing, with the option to select a 
pipeline 

  Insert vent 
Inserts a vent in the sewage stack in the form of a soil 
vent or a vacuum relief valve 

  Insert inside drain  Inserts an inside drain in the rainwater pipeline 

  
Inserting branch lines for 
sanitary fixtures 

Enables defining group branch lines from a stack to 
sanitary fixtures. Activates the branch lines 
organization configurator. 

  
Change installation 
height 

Enables changing the height of a sewage installation 
item group by the selected value 

  
Insert sewage 
installation extension 

Enables generating an extension of the internal 
sewage installation 

  

Insert sewage 
installation branch 
extension 

Enables generating an extension of the selected 
sewage installation part 

  Insert sewage profile*  
Enables generating a profile for the internal sewage 
outlets  

  
Create an internal 
sewage profile 

Enables defining the organisation of side profiles from 
the main profile 

  Insert material list* Inserts a material lists table into the drawing 

  
Insert material list from 
selected elements 

Insert material list from installation elements selected 
on the projection 

  Insert item list 
Inserts an item list of the sewage installation along 
with the graphical symbols, names, markings and 
quantity 

  
Insert selected elements 
list 

Inserts the list of the installation elements selected on 
the projection 

  
Sewage installation 
verification 

Generates a list of items that have been designed with 
errors. Identifies pipe sections with the wrong 
functions in the sewage line 

      
 Determine diameters of 
outlet lines* 

Displays the calculation tables and generates a report 
presenting the technical calculations and the validity 
of the designed sewage installation of outlet pipelines. 
Generates calculation reports. 

  
Selection of sewage 
stacks 

Enables the designer to easily verify whether sewage 
stacks were correctly selected. Generates calculation 
reports. 

   Project options Displays project options 
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 Show help Displays the software help contents 

* Icons marked with this triangle are extendible icons that have more than one command 

3.2.1 General software options 

The ArCADia software: 

After clicking the icon: The System ribbon  Options logical group   displays a dialogue box 
with the general options of ArCADia. 

 

AutoCAD or ArCADia-INTELLICAD software: 

After clicking the icon: Architecture   toolbar 

or input ISA_O 

 This window includes the tabs of the available ArCADia software. 

 

 ArCADia system options window 

On the left side of the options window the last button is Options for inserting elements. After 

clicking on that button the following window appears: 
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 Tracking options window 

On the left side the user may define how precisely (maximum distance from the element axis which 

will allow for detection) will the elements, axes and angles be detected while element axis  and 

angles  tracking is enabled and elements detection  is enabled. 

Angles tracked may be inserted on the right side of the window. In the table the user may add, using 

the  button, another angle that he wants to be tracked when entering elements. If the user wants 

to delete one of the angles, he needs to select it by clicking it in the table and then delete one of the 

values using the  button on the right.  

After defining the detection and tracking precision, the number of angles tracked and their values, 

the user may confirm changes using the OK button (changes will be saved in the software) or discard 

them using the Cancel button (all changes done in the in the tracking options window will be 

canceled). 

 

The project options window is displayed after selecting the ArCADia-SEWAGE INSTALLATIONS tab. 
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 Software option window: General tab 

In this window the user may change the general software settings relating to the design of sewage 

installations: 

Parameters control group 

Installation 

The Show pipe connection cups option enables the visualisation of connection cup symbols. 

Cup to pipe end distance enables setting the distance between the symbols and the connection 

point. 

 
Profile 

Pipe view – this feature provides the possibility of defining a global setting for the entire project, 

and the view of the pipelines in the profile. When selecting the Pipe bottom item the pipeline 

view in the profile will be generated with a single line symbolizing the pipeline bottom. 

After selecting the Pipe cross-section with axis feature a view of the pipeline cross-section along 

with the pipe axis will be generated. The third feature is the cross-section without an axis, where 

the pipeline will be drawn symbolically as the channel’s Pipe cross-section. The view creation 

feature is also available for each pipe section individually in the generated profile by double-

clicking the pipe and changing the view settings for the particular section only. 
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 Software option window: Symbols tab  

Project options tab – Default symbols 

Items 

The user has the option to skip or introduce his own markings for the sewage installation items. The 

inserted markings will be inserted automatically when inserting items. The user may change the 

symbol for the particular item type individually for each item. The symbols will be inserted in the 

projection and in other views, e.g. extension, profile. 

Fittings 

As above, the user has the option of inserting a fitting item. The difference consists in the fact that 

the fitting is not an item inserted by the user, but only modified. A symbol is created at the same 

time when pipelines are connected as a set of fittings, with the symbol being determined for the 

main fitting, in this case for the elbows, three-way fittings and four-way fittings. Connections creating 

calculation points and characteristic points in the views such as the profile.  
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 Software option window: Fittings 

The project options Fittings tab is used for selecting and/or changing the default settings for the 

connections (Fittings) created in the project when inserting the route of a sewage installation. 

Appearance 

Connect with angle fitting – used for changing the automatic creation of connections between 

pipelines in the form of angle fittings. If the user introduces an installation route with the IntelliCAD 

or AutoCAD Ortho feature (inserting at a 90˚ angle or without it, however on condition of inserting at 

a straight angle in relation to the existing pipeline), they have the possibility to automatically detect 

and insert angle connection fittings i.e. 45˚ elbow or 60˚ three-way fitting. In order to have such 

connections created automatically upon insertion you need to tick the check box located on the left 

at the Connect with angle fitting headline. 

Below that the user will be able to define what default connections are to be created depending on 

the number of pipes being connected, that is the type of the fitting. In the case of three-way fittings 

the branch angle in relation to the pass-through and in the case of three-way fittings – the angle of 

both branches. 

Note! In each fitting (Fittings set) you can individually change the default settings and introduce the 

necessary angle or completely disable the angle fittings insertion feature. 

If the user does not tick the Connect with angle fitting check box, the connections will be done in the 

form of resulting fittings with free branch angles generated at the moment of connecting pipelines. 

You can therefore obtain a 57˚ three-way fitting, which gives the option of inserting fittings that are 

rarely used or custom-made. 
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Detection 

Connect into reduction fittings – this feature allows setting the default connections executed in the 

form of reduction fittings (check box ticked) or a fitting and a reduction item (check box unticked). 

This means that by default the user will have e.g. a DN100/Dn50 three-way reduction fitting or a 

DN100 three-way fitting and a DN50 reduction, whereas the remaining parameters, such as the angle 

and material of the fitting depend on the other settings and parameters of the pipelines introduced 

into the project. 

Angle detection precision and angle list – this feature allows determining to which connection 

angles a pipe connection without the connect with angle fitting feature should be reduced. 

Example: 

A user unticks the connect with angle fitting feature, e.g. when the installation route is not plotted 

using the ortho feature (straight angle) and wants the connections to be created automatically, 

however with reference to the products existing in the market and not depending on what is the 

precision setting used for inserting pipelines into the project. Then the connection at any angle will 

be reduced to the angle provided in the detected angles list. Detection can be reduced to the 

appropriate number of degrees. Same as in the settings from  REF _Ref354433293 \r \h Fig., the 

connection of two pipes at a 28˚32’ angle will be listed as a 30˚ elbow (5˚ detection). 

 If in the case of the above example set of typical angles the users sets 2 ° in the "Angle detection 

precision" field, then: 

 angles in the range of 28 – 32° will be treated as 30° 

 angles in the range of 43 – 47° will be treated as 45° 

 angles in the range of 58 – 62° will be treated as 60° 

 angles in the range of 88 – 92° will be treated as 90° 

This facilitates the quick insertion of an installation route with low precision, e.g. for the purposes of 

a material list or creating a simplified bill of values. 

Adding subsequent items is possible after pressing  and items may be removed after clicking the 

particular item with an angle provided and clicking . 
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4 DESCRIBING AND EDITING ITEMS 
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4.1 PRELIMINARY NOTES ON ITEM EDITING 

Editing each item consists in inserting an item symbol to the blueprint. The software offers two types 

of items divided due to the definition of their characteristic geometric real dimensions, i.e. : items 

that require geometrical parameters to be defined and items that are only reflected as graphical 

symbols, without defining their real dimensions. 

The item symbol includes information about the characteristic parameters, i.e. technical, process and 

geometric parameters of the item (if required), which are necessary to execute supplementary 

drawings, calculations and verify their validity. 

An item is inserted in the model by selecting the appropriate icon from the software toolbar Fig. 1. 

The item insertion window appears. The window for each item enables selecting the item location by 

defining a handle in the contour or the item’s characteristic point and enables spatial localization 

(etc. Installation level of the selected characteristic item). 

 

 Element  insert window: Sewage pipe 

 

Icon Description 

 Import for element 

 Parallel offset 

 Offset direction 

 Insert vertical section 

 Tracking axes 

 Tracking angles 

 Element and section detection 

 Reference 

 Between points (center) 
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 Between points (percentage) 

 

By selecting the Import from item  button the user may insert an item connecting it at the 

appropriate characteristic point for the particular item with the connecting items of another item 

that has already been inserted into the drawing. 

The window also includes options that facilitate accurate insertion of the item. These features are 

activated by pressing the appropriate buttons for tracking  or detection  of other items 

already included in the drawing. 

Pressing  allows drawing vertical sections of the installation without deactivating the horizontal 

pipe insertion command. 

 
There are two ways to insert an item into a drawing: 

Method #1. 

After selecting the appropriate icon from the ArCADia-SEWAGE INSTALLATIONS (Fig. 1) toolbar, an 

item insertion window will appear. When it appears, the user can edit the item's parameters by 

selecting the button  which corresponds to the Item properties in the item insertion window. 

After that, the Item properties window will appear, allowing the user to change the item 

characteristic parameters. After changing the settings, press the OK confirmation button which will 

bring you back to the item insertion window and click with the hooked item symbol in a chosen place 

on the drawing field. Such an item insertion procedure ensures that the parameter settings and 

fonts, pens and areas are saved for each subsequent item of the same group. 

Method #2 

After selecting the appropriate icon ( REF _Ref354132933 \r \h Fig.), insert the item symbol using the 

item localization feature. Next select the item, which will display a toolbar that allows modifications. 

 

 Item modification selection toolbar 

Icon  Description 

 
Go to properties dialog 

 
Fonts and pen painter 
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Type painter 

 
Description painter 

 
Edit description 

 
Set description on the link 

 
Create actual view 

 
Object renumbering 

 
Lengthen/shorten pipe maintaining slope 

 

 

Move with connections  

Move without connections 

 
Delete marked objects 

 
Project library / Global library 

 

You can edit the item's parameters by selecting the  button. Once the parameters are set in 

the Item properties window, you can press the OK confirmation button, which will change the 

parameters of the previously inserted item. 

The Item properties windows are used to set the characteristic, geometric and technical parameters 

of an item and are divided into control groups for every item: 

Control group – Item management 
 
Symbol – setting the name displayed on a projection along with the item's subsequent number. If 
the user does not implement any change in the active window, the name will be generated from the 
Options window. 

Item id – the number of the subsequent inserted item of a particular type 

Type – Allows the user to insert items with shared parameters into the project library and the global 

library. 

Group – common for every item. Allows the user to group selected items and transferring them to 

the Project Manager.  
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NOTE! It is very important that the division into groups includes all the items and using default 

groups the user can define the purpose for a particular sewage installation (sanitary blackwater or 

greywater drainage, rainwater drainage or process drainage). While drawing the first item, the user 

will assign it to an appropriate group and the next item of that type will automatically be drawn in 

this group. 

Appearance control group 

The set of controls included in this group is the same (or very similar) for all domain items included in 

the software. 

Description appearance – allows to start the description content settings configurator and its 

organization. The user decides whether a description will appear on a projection by marking the 

Description on projection check box. 

Angle – by changing the value in the editing field, the user can change the angle at which an item will 

be inserted. 

Pens – setting the thickness, contour drawing lines on a model and 3D view. 

Fonts – setting the font format for the name displayed in drawing projections. 

Surfaces – setting the colours and patterns of the surfaces visible in 3D. 
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 Item properties window – General appearance 

Parameters control group 

Individual controls set for each item. Allows the user to set the defining installation parameters, for 

example the item location, its functions, elevation etc. 

Type parameters control group 

Individual controls set for each item. Allows the user to set the parameters that specify a particular 

item etc.: technical or geometric parameters (diameter, material etc.). 

Approve (save/cancel) control group 

 

 Save/cancel buttons 
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Save in a template – allows the user to save the default for a particular template of a particular item 
type. 

 – the button allowing the user to restore the default settings for a particular type. 

OK – approve and implement changes. 

Cancel – delete changes and return to the previous window. 

 

Once the check box on the left side in the Appearance control group is selected (ticked), the 

Description button becomes active and once it is pressed, the description appearance configurator 

window appears. 

 

 Description configurator – main window view 

In this window the user may set the technical contents of the description components (different for 

the particular item) and their sequence of placement and localization in relation to the description 

line. 

After pressing the appropriate (upper or lower) line content button, an additional window is 

activated where you can select the appropriate layout and contents Fig. 7 (example of setting the 

bottom line for a pipeline description). 
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 Description configurator – settings window view 

There are two tables in the description configurator window: on the left side there are the available 
components and on the right side there are the contents of the particular line. The availability of 
components for a particular line depends on introducing them into an inactive line. Inserting a 
description on the selected line consists in selecting the description name and pressing the arrow 
towards the line description content table. The selected description title will be transferred and 
therefore won't be available in the Available components table. Should the user wish to share the 
component, he needs to act in a similar manner, marking the description components in the line 
content table and then use the arrow to transfer these to the available components table. 

The sequence of description components in a particular line is set from left to right as per the top-
down sequence in the line contents table. You can change the sequence by marking a component in 
the line contents table and controlling the sequence change buttons, which causes the sequence of 
the particular component to be changed by one field. Each use of the arrow moves the item one field 
up or down. After pressing the Close button the changes will be applied. 

NOTE: If we select several pipelines with different descriptions (the square next to the description 

will be filled blue), we will have the possibility to change the description for every pipeline 

simultaneously. In that situation, the description configurator will set an empty description in the 

link. Click the description control and set the appropriate description components. 

 

By clicking the  Edit description button on the item modification toolbar (Figure 5), you can open 

the item description editor. The description editor window will become available (Figure 8a) 
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 Description editor window 

 

Icon Description 

 Enable/disable description 

 Enable/disable link 

 Change direction 

To export description settings from an item, you should choose the  Description painter button 

on the item modification toolbar (Figure 5). A window will appear where the user can select which 

description parameters will be transferred ("painted") onto another item’s description by unticking 

an appropriate check box.  

 

 Description painter selection window 

The available parameters include: 

Visibility – transfers the enabled/disabled description settings 

Link – transfers the description settings with/without a link 

Direction – transfers the vertical/horizontal description settings 

Offset from object – transfers the description position settings in relation to the item onto a 

subsequent item 

Content – transfers the description lines content set in the description configurator 
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In order to renumber installation items, you should press the  Object renumbering button on the 

item modification toolbar. A renumbering window will appear. In this window you can set: 

 The symbol of an item from which you want to begin the renumbering 

 Manner of renumbering: after unticking the field items will be numbered from the digit 

symbol up, when the increase field is ticked, the software will assign the same symbol to all 

items of a particular type 

 Automatic renumbering 

 Direction: from which corner of the document the renumbering process should start and if it 

"goes" vertically or horizontally 

 Range: renumbering items in the whole building or only on the active level 

 

 Item renumbering window 

"Sticking" items, i.e. fittings, is a very useful additional feature to be used during the design process. 

An inspection opening or a cleanout for the pipeline onto which it is inserted. This means that every 

change in the length or slope of the pipeline will automatically force the item to change the 

installation level and position on the projection. Obviously, inserting each item independently, i.e. 

not connecting it to a particular pipeline, is possible. This option comes in handy while installing a 

fitting on an already existing installation in an already existing project (modernized item). 

Note! The feature of connecting fittings with a pipeline is a new feature and it’s available in the 

ArCADia-SEWAGE INSTALLATIONS module.  

4.2 EDITING AND INTRODUCING TYPES 

The ArCADia software: 

After clicking the icon: System ribbon  Libraries   logical group  

AutoCAD or ArCADia-INTELLICAD software: 

After clicking the icon: Architecture    toolbar 
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or input ISA_ETL 

The Type library editor is used to edit and introduce new item types into ArCADia. It facilitates   

access to manufacturer's catalogues and enables selecting only those catalogues that the user 

uses most often when designing.Additionally, types are divided into a Standard library (i.e. the 

library provided with a given software version) and a User library, where all the new or user 

modified element types are saved. 

 

 Type editor window 

In the upper part of the type editor  (Fig. 17) window the user has the possibility to select a 

branch from the drop-down list where all the branch-modules available in ArCADia are listed. 
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 View of the expanded list of branches available in ArCADia 

After selecting the appropriate branch the user has access to all the items, e.g. sewage pipe, available 
in the selected branch (module) from the Items drop-down list (on the right side).  

 

 View of the expanded list of branches available in ArCADia 

After clicking on the selected item in the Global library all item types will be available. During the 

first run it will be the types available in the software by default. Additional types can be added to the 

libraries during the design process. 

 

 Types library editor window after selecting the appropriate branch and one of its 
items 
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Lower part of the editor window is divided into the Global Library page (left) and Design Library page 

(right). 

The Global library is the place where all the default element types available for the user and the 

elements added when working with the software are added; it is divided into the Standard library (a 

library provided with a given version of the software, which the user does not change) and a User 

library, which contains elements (types) saved by the user when working with the software. 

Project library – where all the element types used or available for use in the project are listed. A type 

for an element can be selected from the Element properties window: 

 

 Type entry point from the item properties level 

as well as in the modification and insertion windows 

 

 Type entry point from the item modification and insertion window level 

Above the type library windows there are icons with the following functions: 

Add new type  – after clicking this icon the user has the possibility to add a new type to the Global 

library or the Project library. Type properties for the particular item, where the user may determine 

all the parameters of the item that are characteristic for it are, among others, the type parameters, 

view. 

Note!!! Clicking the Add new type icon when a type has been previously highlighted in the Library 

will add a new type based on the highlighted one. This facilitates the input of a catalogue of items to 

the library, e.g. supplied by one company, where the only distinctive feature is e.g. the diameter of 

the pipe. 

Add new folder  – after clicking this icon the user has the possibility to add a new folder, where he 

can then later add item types. A folder name input window will appear. After entering the folder 
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name you need to press the  button in order to add the folder to the library or 

 to cancel the command. 

 

Fig. 23. Folder types insertion window 

Delete  – after clicking this icon the user may delete the selected type or folder. 

Type properties  – after clicking this icon the user will have access to the properties of the 

selected type. He can edit and save these values here.  

Leave only the types used in the project  – after clicking this icon in the Project library, only the 

types used in the project (used in any object in the project) will remain visible. 

After clicking a type with the right mouse button, a menu becomes available: 

 

Type properties – works the same as the icon described above. 

Copy – copies the type. 

Paste – pastes a previously copied type and inserts it with the same name and subsequent number. 

Rename – the user may rename an already inserted type. 

Delete – works the same as the icon described above. 

Above the project library there is the  button. Once you click this button the 

Project library settings will be saved in the template and will be accessible for future projects with 

this template. After clicking the  icon placed next to it the user obtains a list of available 

templates. 
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Fig. 24.Example Properties window 

In the Project library window you can also check what types of a particular item are currently in use 

in the projection, which is displayed in the form of the  symbol on the left of the name of a 

particular type. 
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 Type library editor window after saving a type in the project library 

Below the two libraries there are the Hide everything  icons – once you click this icon the type 
tree in a particular library is reduced to the root folders. 
The user may also search the type library by typing part or the entire name of the desired type in the  

 field. The search field will be cleared after clicking the  
button. 
Once you select types or folders, the transfer buttons located between the libraries are activated. 

Copy all to the project library  – copies the entire global library content to the project library. 

Copy to the project library  – copies the selected items to the project library. 

Copy to the global library  – copies the selected items to the global library. 

Copy all to the global library  – copies the entire project library content of the selected item to 
the global library. 
 
Messages that may be displayed when working with the Type library editor: 

1. This message informs that there is already a type with this name. After clicking the 

 information from the new type will be saved and will overwrite the information 
in the previous type.  
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2. This message informs that the types marked by the user were removed. The  
button confirms type deletion. 
 

 
 

3. This message informs that the layout of the project library was saved to a project template, 
e.g. Standard. 

 

NOTE! If the user has made any changes in the Project library while working with the project, 

modified existing types or expanded the library by adding new types, the new types will become 

available for future projects. The user should add the new types to the Global library using the 

transfer buttons. 
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4.3 OUTFLOW POINT FOR A SEWAGE LINE 

The Outflow point for a sewage line item is inserted to the model once the icon is selected; 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations  toolbar  

or input ISWR_OP 

An item insertion window is displayed. The item is the virtual point to which the sewage from a 

particular sewage (system) section is drained. The point is usually located outside the building. 

 

 Settings window for the outflow point of the sewage line. 

The connection point symbolizes and defines the manner of connecting the designed outlet sewage 

pipeline along with the sewage receiving installation. 

The window allows the user to set the appropriate insertion position for the point of connection by: 

 Having the user select an anchor on the contour or the middle point of the symbol. 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 Setting the installation level settings (nesting) in relation to the level where the item is drawn 

– pressing the Import from item  button allows adjusting the axis depth to the previously 

drawn item (e.g. pipe). A minus sign means inserting the pipeline below the surface of the 

active level. 

The window also allows the user to use the software’s libraries. The user can select an exemplary 

type of connection fitting used in the project from the drop-down list of a particular library. 

When the connection point insertion window is active, a conventional marking of the particular 

connection point appears in the model's drawing field (projection). Clicking a chosen spot inside the 

drawing area inserts a designation symbolising the item. The marking on a projection of this item 

does not have the actual dimensions and is meant solely for demonstrative purposes. Setting the size 

(if the marking is supposed to be more or less visible, the user has to change its size in the options 

window by configuring his own symbols scale). After selecting the symbol in the projection, the 

software will display an item modification window. 
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 Modification window for the sewage line outflow point item 

By selecting the button  or double-clicking on the inserted item the sewage line outflow point 

properties editing window appears. 

 

 Item properties window – sewage line outflow point 

Parameters control group. 

Setting the installation and process parameters of the sewage line outflow point: 

Bottom installation level – the user inputs the value of the required vertical distance in relation to 
the floor surface in the active level 

Ordinate in relation to building zero level – the relative ordinate is published in the window 

Type parameters control group 

Frequency factor 

In this part the user chooses from a drop-down list the appropriate type of the building in which 

the indoor sewage installation is being designed. This way the appropriate frequency factor K, 

characteristic for a particular type of building, is defined. 
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Additional description – an editing field where the user can insert their own information that will 
then be published in lists. 

4.4 INSPECTION AND CONNECTION WELL 

The Inspection and connection well item is inserted into a model after selecting the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_W 

An item insertion window is displayed. 

 

 External inspection and connection well insertion settings window 

The window allows the user to set the appropriate insertion position for the well by: 

 Having the user select an anchor on the contour of the well or the middle point. 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 Well bottom installation level settings – pressing the Import from item  button allows the 

user to adjust the bottom height to the existing item (e.g. the pipeline).  

The window also allows the user to use the project libraries. From a drop-down list the user can 

select an example type of a well used in the particular project. 

When the well insertion window is active, an item symbol shows up in the model's drawing field 

(projection). Clicking a chosen spot inside the drawing area inserts an item. After selecting the item, 

the software will display an item modification window. 
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 Inspection and connection well item modification window 

 The well properties editing window is displayed by selecting the  button or double-clicking 

the inserted item. 

 

 Item properties window – inspection and connection well 

In the item properties window you can adjust the appearance of the item in the projection, as well as 

the installation and technical parameters. 
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Parameters control group. 

Well bottom type – the user selects the bottom shape from the drop-down list: well bottom without 

a profile (for example sump well or cooling well), one-way manhole base (profiled into the duct 

shape) 

Manhole installation level – the user defines the top of the well height in the editing field (over or 

under the floor). The relative ordinate is displayed next to it. 

Bottom installation level – in the editing field the user defines the well bottom height (if the well has 

a flat bottom or is a manhole base (if the well has a profiled bottom)). The relative ordinate is 

displayed next to it. 

Minimum connection height – the minimum height from the bottom of the well at which the 

pipeline can be connected 

Type parameters control group 

In this group the user inputs the characteristic (specifying) parameters of the well: 

Name – input the name of an item e.g. inspection well 

Standard/Manufacturer – in this field you can enter the standard number or the Manufacturer of a 

particular item. 

Type/Series of type – this is a field in which the user inputs the item type or it’s series of type or the 

catalogue number 

Shape – the well projection shape is selected from a drop-down list. 

Well projection dimensions are defined in the editing fields below basing on its shape 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

4.5 OUTFLOW PIPELINE FITTINGS 

The items that symbolise the fittings installed on the outlet pipes are inserted into the model after 

selecting the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar  

or input ISWR_AS 

An item insertion window is displayed. 
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 Fittings insertion window  

This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 The installation level values on the pipeline are obtained by pressing the Import from item  

button, which allows to automatically connect a fitting to the pipeline. The item connected to the 

pipeline will split the pipe into two parts. 

The window also allows the user to use the libraries. From a drop-down list of a particular library the 

user can select an example type of fitting and its application in the project. 

After selecting the inserted item the software will display an item modification window. 

 

 Fittings item modification window 

The fittings type properties editing window is displayed by selecting the  button or double-

clicking the inserted item. 



ArCADia-SEWAGE INSTALLATIONS      User Manual 

Describing and editing items 

 

44 

  

 Fittings properties window 

Parameters control group. 

Height in relation to the level – the user inserts the value of the required height or nesting in 

relation to the surface of the active level. 

Height in relation to building zero – displays the height of the item in relation to the zero of the 

building where the installation is included 

Casing – after ticking this field the user has the possibility to define the fitting protection item (for 

example a well).  

Additional equipment – a window where the user may select and add additional equipment that will 

be included in the material list. 

Type parameters control group. 

Name – input the name of an item e.g. backwater valve or select it from a drop-down list 
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Standard/Manufacturer – in this field you can enter the standard number or the Manufacturer of a 

particular item. 

Type/Series of type – this is a field in which the user inputs the item type or it’s series of type or the 

catalogue number 

Connectors material – from a drop-down list the designer selects the connector pipes material for 

the particular item 

Nominal diameter – from a drop-down list the designer selects the nominal fitting diameter. If the 

Automatic check box next to the diameter is unticked (the parameter is set by default), then 

selection of the valve diameter is blocked and the valve only assumes the diameter of the pipeline to 

which it is inserted. 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

 

 Fitting casing definition window 
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4.6 CLEANOUT 

The item symbolizing a cleanout can be installed on a vertical and horizontal pipeline. 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_CO 

An item insertion window will appear. 

 

 Cleanout insertion window 

 

This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the 

items detection, sections detection  , items tracking and section ends tracking  

features. 

 The installation level values on the pipeline are obtained by pressing the Import from item 

 button, which allows to automatically connect a cleanout to the pipeline at an 

appropriate height. If the button is not pressed, the cleanout will be inserted at the height 

provided in the editing field next to the icon. 

The window also allows the user to use the project libraries.  

The user can select an exemplary type of items and application in the project (type) from the 

drop-down list of a particular library. 

After selecting the item an item modification toolbar appears. The item modification toolbar give the 

user an additional modification possibility that is not available for other items. 

 

 Cleanout item modification toolbar 
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The cleanout type properties editing window is displayed by selecting the  button or double-

clicking the inserted item. 

 

 Clean properties window 

Parameters control group. 

Height in relation to building zero – the user inserts the height in relation to the floor of the active 

level [cm]. 

Height in relation to the building zero – the software automatically fills the item height in relation to 

the building zero in [m] units. 

Additional equipment – here the user may add additional equipment items that will be included in 

the material list but will not be drawn 

Type parameters control group. 
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Name – in this field the user may change of a particular item or give it a new name. 

Standard/Manufacturer – in this field the user can enter the name of the standard or the 

manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Shape – the user may select the cleanout hole shape (round or rectangular) from the drop-down list 

Diameter – the user inputs the cleanout hole diameter or the width and height in case of a 

rectangle. 

Length – the user inputs the length of a cleanout installed on the pipeline. 

Nominal diameter – the user may determine the nominal diameter of a cleanout or by ticking a 

check box the cleanout diameter will be automatically imported from the pipeline onto which the 

cleanout will be inserted. 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

4.7 INSPECTION OPENING 

Items symbolizing an inspection opening installed on horizontal pipelines of an internal installation 

are inserted into the model by pressing the icon: 

The ArCADia software: Sewage ribbon  Sewage installations  logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_SI 

An item insertion window is displayed.  

 

 Inspection opening insertion window 

This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 
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 The installation level values on the pipeline are obtained by pressing the Import from item 

 button, which allows to automatically connect an inspection opening to the pipeline at 

an appropriate height. If the button is not pressed, the inspection opening will be inserted at 

the height provided in the editing field next to the icon. 

The window also allows the user to use the project libraries.  

The user can select an exemplary type of items and application in the project (type) from the 

drop-down list of a particular library. 

After selecting the item an item modification toolbar appears. The item modification toolbar give the 

user an additional modification possibility that is not available for other items. 

 

 Inspection opening item modification toolbar 

The inspection opening properties editing window is displayed by selecting the  button or 

double-clicking the inserted item. 
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 Inspection properties window 

Parameters control group. 

Height in relation to building zero – the user inserts the height in relation to the floor of the active 
level [cm]. 

Height in relation to the building zero – the software automatically fills the item height in relation 
to the building zero in [m] units. 

Top installation level – the inspection opening plug top height value is provided in this place. It can 

be set automatically (with the check box ticked) or manually typed into the editing field by the user 

[cm] 

Additional equipment – here the user may add additional equipment items that will be included in 
the material list but will not be drawn 
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Type parameters control group. 

Name – in this field the user may change of a particular item or give it a new name. 

Standard/Manufacturer – in this field the user can enter the name of the standard or the 
manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Shape – the user may select the cleanout hole shape (round or rectangular) from the drop-down 
list 

Diameter – the user inputs the cleanout hole diameter or the width and height in case of a 
rectangle. 

4.8 MOULDER 

The Fitting item is inserted automatically at the connection of pipelines. The default fittings insertion 

settings can be changed in General software options. 

A set of fittings is created at such a connection site and the user may select different manners of 

executing such a connection, e.g. whether the fittings are to be reduction fittings. 

After clicking the fitting item and selecting it from the project tree in the project manager, 
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 Project manager window 

a modification window  Fig. 43 will be available. 

 

 Fitting modification window 

The user may change the colour and thickness of the line pen, the colour, size and type of font used 

for the description, as well as modify the appearance of the fitting surface in the projection. 
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After clicking the  icon or by double-clicking the fitting item, the fitting properties window will 

be activated. 

 

 Sewage fitting properties window 

There are three groups of controls available in the window: 

Appearance 

The user may change the colour and thickness of the line pen, the colour, size and type of font used 

for the description, as well as modify the appearance of the fitting surface in the projection. 

It is also possible to insert a fitting description after ticking the description checkbox. The description 

configuration window will be activated after clicking the description button. The default description 

is set as the fitting symbol, for example T14  
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Parameters 

Connect with angle fitting – after ticking the check box the fitting will be created with the angle 

provided next to the fitting. This means that if two pipes will be drawn in the projection at a straight 

angle e.g. using the ortho drawing feature, the connection fitting between them will be inserted 

automatically with the fitting angle input in the properties. 

Set – table with the sets of possible connection sets. After clicking a particular row the user may 

check exactly how many and what type of fittings are included in a particular set. 

 

 Properties window with an expanded list of a particular fittings set 

If the user has selected the appropriate set, they confirm the selection with the OK button and close 

the properties window.  

A fitting set created by this method is automatically added to the material list. 
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 Example of a material list 

4.9 SEWAGE POINT FOR SANITARY FIXTURE 

 The sewage point for sanitary fixture item is inserted into a model after selecting the icon: 

The ArCADia software: Sewage ribbon  Sewage installations  logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_DO 

 

An item insertion window is displayed. The item provides the pipeline inlet for the sewage from the 

sanitary fixture or, in other words, the connection point of the sanitary fixture outflow item (e.g. 

drain trap outflow) with the internal sewage installation pipeline. 

 

 Sanitary fixture outflow point insertion window 
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This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 Pipeline bottom installation level settings are adjusted by entering the installation level value 

into the editing field or by pressing the Import from item  button, which enables 

automatic connection of the outflow with the pipeline. The window also allows the user to 

use the project libraries or the global libraries. The user may select and example type of 

outflow for a particular sanitary fixture from the drop-down list of the particular library and 

use it in the project. 

After inserting a particular item and selecting it, the item modification window appears. 

 

 

 Fixture outflow item modification window 

A sanitary fixture outflow point properties defining window is displayed by selecting the button 

 or double-clicking the inserted item. 
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 Sanitary fixture outflow point properties window 

Additional controls were introduced into the Appearance control group that enable creating views of 

the sanitary fixture for which the outflow point is meant. 

If the user does not tick the Show fixture field, then the symbol of the sanitary fixture will not be 

inserted into the projection and the item will not be visible in the 3D projection. This course of action 

may be selected by the user if the received an architectural projection with sanitary fixtures already 

marked. Should the user want to introduce markings for a particular fixture into the projection, then 

he ticks the Visible fixture field and may define the dimensions of the fixture available in the type 

parameters. The fixture’s location may be set by grabbing the handle of the graphic symbol and 

dragging it to the appropriate location. You can also move using a general CAD software command. 

Rotating a fixture symbol is possible using the Rotate with base point CAD command or by entering 

the rotation angle value in the fixture properties dialogue box. 

Profile characteristic point – unticking this field gives the user the possibility to generate a profile 

that ends with the selected fixture. The item will be visible in the profile. 
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Parameters control group. 

Height in relation to the level – the user inserts the value of the required height or nesting in 

relation to the surface of the active level. 

Height in relation to building zero – displays the height of the item in relation to the zero of the 

building where the installation is included 

Fixture top installation height – the user inputs the sanitary fixture installation height by entering 

the height of the fixture’s top above the level. 

Additional equipment – a window where the user may select and add some additional equipment 

that will be included in the material list in the material lists 

Type parameters control group. 

Name – in this field the user may change of a particular item or give it a new name. 

Standard/Manufacturer – in this field the user can enter the name of the standard or the 

manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Branch diameter – a drop-down list with input options. 

Unit outflow – the values in the editing field are set by default (recommended) depending on the 

selection of the device and sewage system. 

The user can input the fixture dimensions in the fields provided at the side. 

 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 
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4.10 VENT  

Items that symbolize vents installed on indoor installations vertical pipelines are inserted into the 

model by selecting the following icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_V 

An item insertion window is displayed.  

 

 Vent insertion window 

This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 The installation level values on the pipeline are obtained by pressing the Import from item 

button , which allows to automatically connect a fitting to the pipeline. 

The window also allows the user to use the software libraries or the global libraries. The user can 

select an example type of item and its application in the project from the drop-down list of a 

particular library. 

After selecting the item an item modification toolbar appears. The item modification toolbar give the 

user an additional modification possibility that is not available for other items. 

 

 Vent item modification toolbar 

The dragging function allows the user to insert a soil vent on the roof surface. On the drawing the 

bottom end of the soil vent connects with the roof surface. It is especially recommended to use this 

feature in the case of sloped roofs, where the soil vent will be located in the sloped roof surface. 
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The vent type properties editing window is displayed by selecting the  button or double-

clicking the inserted item. 

 

 Venting properties window 

Parameters control group. 

Height in relation to the level – the user inserts the value of the required height or nesting in 

relation to the surface of the active level. 

Height in relation to building zero – displays the height of the item in relation to the zero of the 

building where the installation is included 

Additional equipment – a window where the user may select and add some additional equipment 

that will be included in the material list in the material lists 

Type parameters control group. 

Name – in this field the user may change of a particular item or give it a new name. 
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Standard/Manufacturer – in this field the user can enter the name of the standard or the 

manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Nominal diameter DN – a drop-down list with an input option next to the checkbox – automatically 

ticked will import the diameter from a pipeline 

Height – vertical dimension of the soil vent 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

4.11 INSIDE DRAIN  

Items symbolizing inside drains installed on internal vertical sewage installation pipelines. These are 

inserted into the model after selecting the following icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_GR 

 An item insertion window is displayed. 

 

 Inside drain insertion window 

This window enables: 

 Selecting the feature of inserting in relation to the items already drawn, i.e. setting the items 

detection, sections detection , items tracking and section ends tracking  features. 

 The installation level values on the pipeline are obtained by pressing the Import from item  

button, which allows to automatically connect a drain to the pipeline. The window also allows 

the user to use the project libraries or the global libraries. The user can select an example type of 

item and its application in the project from the drop-down list of a particular library. 
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 Inside drain item modification toolbar 

In the item modification toolbar, similar as in the case of a vent, the user may drag the surface of the 

inside drain to the roof surface or e.g. a terrace.  

The inside drain type properties editing window is displayed by selecting the  button or 

double-clicking the inserted item. 

 

 Inside drain properties window 



ArCADia-SEWAGE INSTALLATIONS      User Manual 

Describing and editing items 

 

63 

Parameters control group. 

Height in relation to building zero – the user inserts the height in relation to the floor of the active 

level 

Height in relation to building zero – displays the height of the item in relation to the zero of the 

building where the installation is included 

Additional equipment – a window where the user may select and add some additional equipment 

that will be included in the material list in the material lists 

Real outflow – outflow value of the inside drain 

Type parameters control group. 

Name – in this field the user may change of a particular item or give it a new name. 

Standard/Manufacturer – in this field the user can enter the name of the standard or the 

manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Shape – the drain projection shape is defined from a drop-down list. 

Nominal diameter DN – the designer selects the nominal fitting diameter from a drop-down list. 

If the Automatic check box next to the diameter is unticked (the parameter is set by default), then 

selection of the valve diameter is blocked and the valve only assumes the diameter of the pipeline to 

which it is inserted. 

Well projection dimensions are defined in the editing fields below basing on its shape 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

4.12 SEWAGE PIPE  

Horizontal pipelines, both outflow and internal, are inserted into the project by pressing the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar  

or input ISWR_SW 

After pressing it, the software will display a first pipeline section ending (beginning) insertion 

window. 

Similar as in the previously discussed cases, by unticking the appropriate check box you can activate 

the tracking and detection features for previously drawn items. 
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 Horizontal sewage pipe insertion window – beginning 

 

 

 Horizontal sewage pipe insertion window – ending 

 

Inserting a horizontal pipeline with a manual insertion function allows the user to insert the starting 

section height as well ending height into the editable field ("start" and "end" of a section are defined 

along with the drawing direction). This operation is executed by ticking the Installation level field. 

The user clicks a starting point of a section and draws a continuous line in the chosen direction and 

finishes by clicking the ending point of a sewage pipe section. 

If the user wants to insert a pipeline with a constant slope, then they need to select the Section slope 

check box. Then the Section level editing field is blocked and the field where you can enter the slope 

in % (Section slope) is unblocked. The direction of the drop is the same as the drawing direction. If 

the user wants the end of the pipeline to be located higher than the beginning, they should insert the 

slope with a "-" sign.  

Pressing the Import from item  button allows the user to add pipeline sections to the points of 

previously drawn items. Selections can be made independently, i.e. the user can select one or both of 

the fields. While editing the beginning of a section, the user inserts the estimated height (as 

accurately as possible) to a point in which the height will be measured. That estimation gives the user 

the possibility to specify which item will be the beginning of the drawing (which benchmark item will 

be the starting point). Ending of the drawing can be compatible with the scheme described above or 

the user can press the Import from item button at the estimated section ending height and add it 

precisely in the desired point. In addition in the section where you define the drawing method, the 
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user can enable and disable the option of drawing in pre-selected angles . This function enables 

the drawing mode according to the angles defined in the options (described in the part concerning 

software options setting). 

Pressing the Parallel offset  button allows drawing an installation in parallel to other items, e.g. a 

wall offset by the selected distance. There are two Offset direction  buttons that allow you to 

choose the offset direction from an item. Next to it there is an editing field where the user should 

input the offset value (the field will activate after clicking the Parallel offset button). 

Pressing the Insert vertical section  button allows inserting without the need to disrupt the 

horizontal and vertical pipelines command. After pressing the button, the insertion window will 

become a horizontal pipe ending insertion window without the possibility to input slope value and 

you need to input the vertical pipeline ending installation level. Next we draw the other horizontal 

sections and at any time the user can insert a vertical section by clicking on the Insert vertical section 

button  

 

 

 Sewage  pipe insertion window  

 

Function marked with an icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar  

or input ISWR_SPR 

enables inserting sections continuously, with different directions with a pre-defined height of the 
beginning of the first section and pre-defined height of the ending of the last section. 
 

After inserting the internal sewage pipeline and selecting the item, an item modification toolbar 

appears. 
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 Internal sewage pipe item modification toolbar 

In the toolbar there are additional icons characteristic only for the pipe item.  

Lengthen/shorten pipe maintaining slope – this procedure allows lengthening or shortening the 

pipeline, maintaining the slope. After selecting a section, the user moves the cursor closer to the end 

of the pipeline and the stretching mark will appear. Then click the left mouse button on it to initiate 

the lengthening/shortening procedure. Next move the mouse in the chosen direction by the selected 

value, which will change the length of a pipeline section. Pressing the left mouse button again will 

end the lengthening procedure. 

The designed pipe section properties defining window is displayed by selecting the  button or 

double-clicking the inserted pipe section. 

Parameters control group 

Bottom installation level - beginning – insert duct beginning bottom installation level 

    - end – input duct end installation level 

Ordinate in relation to building zero – the software automatically fills the item height in relation to 
the building zero in [m] units. 

Actual length and length in the projection – as in description. Parameters will differ if the pipeline is 

routed with a slope and if the Automatically checkbox is not ticked.  

Slope – the value calculated as the difference between the beginning and ending of the pipeline 

installation levels. The slope can be set in the section ending insertion window. 

 

Type parameters control group 

Material – the user may change or input a new material name for a particular item. 

Standard/Manufacturer – in this field the user can enter the name of the standard or the 

manufacturer of a particular item. 

Type/Series of type – here the user may input the series of type of a particular item 

Nominal diameter DN – input the nominal diameter DN  

Outside diameter – input the outside pipeline diameter [mm]. 

Wall thickness – input the wall thickness of a particular pipeline 
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 Horizontal sewage pipe properties window 

Material – The user inserts the material that will be used to build the pipeline sections from a drop-

down list. The designer inserts the materials allowed to be used in the particular section of a building 

according to the applicable standards. 

Nominal diameter – the user selects the nominal diameter of a pipeline section (in accordance with 

the selected series of type) from a drop-down list 

Outside diameter – the pipe diameter is calculated according to the external dimensions and 

corresponds to a particular series of type of a specific nominal diameter 

Wall thickness – pipe wall thickness for a particular outside diameter. Pipe wall thickness can vary for 

a particular outside diameter. Inserting values into the editing fields allows the user to choose any 

series of type of pipelines. 
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Roughness factor – the coarseness coefficient is set by default to match the material to be used for 

building the installation – 0.013 by default. The user can set another value. 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

4.13 VERTICAL PIPE 

Vertical pipeline drawing starts by pressing the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_VSP 

Vertical pipes insertion window will appear after pressing the button. Similar as in the previously 

discussed cases, by unticking the appropriate check box you can activate the tracking  and 

detection  features for previously drawn items. 

The pipeline insertion procedures are determined by the appropriate function setting in the vertical 
sewage pipes insertion window. 

 

 Vertical sewage pipe insertion window 

Inserting Vertical pipelines with a manual insertion function allows the user to type ordinates for 

both ends of the pipeline into the editable fields. A vertical section with the selected section end 

heights is then edited. 

The Import from item  buttons allow the user to add pipeline sections to the points of previously 

drawn items. For this method, editing is done in the same way as in the case of horizontal pipes. 

Import from a level  stretches the appropriate end of the pipeline to the next level surface, 

allowing the user to punch through the ceiling. 

The vertical sewage pipe section properties defining window is displayed by selecting the 

button or double-clicking the inserted pipe section. 
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The window and the functions are the same as in the case of a horizontal pipe. The only difference is 
the lack of drop (vertical pipe). 

You can also define an inspection opening in the vertical outlet pipe by marking the appropriate field 
and then, if necessary, introduce an encased item, e.g. a well. 

If the user chooses the stack function from the drop-down list, they will have to untick the stack 

number in the appearance part and insert the planned number in the symbol description part in 

order to input stack numbers. Starting from the input value, the stacks will be numbered in 

ascending order. 

 

 Vertical sewage pipe properties window 
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After selecting the inserted vertical pipe item, a modification toolbar will appear 

 

 Vertical pipeline modification selection window 

In the toolbar there is an icon allowing the user to stretch vertical pipelines not only in a particular 

level, but also between them. 

After pressing that icon, a dialogue box will appear, where the user can set up to which level the 

vertical pipe will be stretched. After stretching the pipeline that goes through several levels 

constitutes a set of pipelines with the length equal to the level height (this is not a single pipe). 

 

 Vertical pipe stretching window 

In the window you may input the vertical location parameters separately for both ends. The user may 

input the height of the particular end in relation to the building’s "zero" or in relation to the height of 

the selected level (height above the floor). The user selects a particular option by unticking an 

appropriate switch. 

After selecting the Ordinate to building zero level option, the user should input an appropriate 

relative value in the dialogue box. If e.g. the third level is located at the +9.20 level and the user 

would like to place the end of the pipe 1 m above the floor, then he should input +10.20. 

While using the installation height the user should choose the number of the level where the 

particular end should be placed from the drop-down list and then input the height of that end in 

relation to the floor (i.e. 100 cm), relevant to the example above. 

 

NOTE: After inserting a vertical or horizontal sewage installation section, there are two functions that 

support the correct installation design. After selecting a horizontal pipeline, numbers representing 

the installation height (for its beginning and end) will appear on its ends. Apart from that circled 

numbers will appear at the ends of the pipeline, meaning the number of items connected to the 
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particular end. In the case of vertical pipes, once you select it, the above mentioned numbers are 

visible one under the other ant the top ones are assigned to the lower part, whereas the bottom 

ones are assigned to the top part of the selected vertical pipeline section. 

 

4.14 INSERTING BRANCH LINES TO SANITARY FIXTURES 

Once a stack (sewage stack) is inserted into the project, i.e. the stack checkbox is ticked in the 

pipeline properties window, and its branch lines are connected to draw-off points, you can configure 

such a connection. It is of no importance what degree of slope are the pipelines routed with or 

whether they are routed without any slope at all, what is important is for them to be connected to 

the fixture’s outflow point and a stack.  

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_AC 

A branch lines configuration window will appear.  

 

In the upper part of the window the user may select the pipeline catalogue from which the pipelines 

for selection in the branch line configurator will be selected in sequence.  

The green  add button is used for this, whereas the  is used for removal and the  and  

buttons are used to change the order. 

The catalogues that are available are the ones located in the project library. After clicking the green 

plus sign, the software will display a field saying "select". Then the user should click this position on 

the ruler. Two parts will appear: on the left one you can select the catalogue from which the 

pipelines will be selected and on the right one you can select the types from the catalogue that are to 

be available (by default all types from the catalogue are selected). 

 

 Configuration window 
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The catalogue position order in the types available for selection window is important when selecting 

branch line pipelines. Types from the first catalogue have a priority in the software. If as a result of 

the calculations and an analysis of the branch line no can be selected from the first catalogue, then 

the next selection stage will verify whether the required type is available in the next catalogue. 

 

 Branch lines configuration window 

The user may choose the branch lines organization in the drop-down list. There are three types 

available:  

 individual branch for every fixture,  

 common branch for fixture application,  

 ungrouped common branches.  
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 Branch lines configuration window 

 

Depending on the manner of connection of the branches you can input the required slope (2.0% by 

default) separately for each fixture, separately for each fixture group with the same application and a 

single common slope if an ungrouped common branch was selected. 
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5 SEWAGE FITTINGS 

  



ArCADia-SEWAGE INSTALLATIONS      User Manual 

Sewage fittings 

 

75 

5.1 CREATING FITTINGS 

In ArCADia-SEWAGE INSTALLATIONS the fittings are created automatically when inserting a sewage 

installation route in the pipeline connections. Fittings are created in the graphical form of elbows, 

three-way and four-way fittings and sets of several pipes (more than 4 pipelines). Each fitting of this 

type is a connection set consisting of the appropriate number of items necessary to execute a 

connection like that. These connection sets can be configured in various ways. The most optimal 

items, that are most closely adapted to the project requirements are selected by default, however in 

the sewage fittings properties it is possible to change the settings and select a different set of fittings. 

Basic fittings generated by the software in the Material specifications: 

- direction (angle) change, for example a 40° elbow, 

- diameter change, for example a DN100/DN50 reduction, 

- branch: three-way fitting, four-way fitting, "x" pipe connection, 

- material change. 

Fittings are created in two ways, depending on the method of drawing the route. 1. If the user users 

the Ortho feature, the fittings will automatically be created as angle fittings or when connecting to a 

pipeline at a straight angle, the angle settings will be adjusted as per the Project options,  Fig. 5 

2. If the route runs at straight angles, then the fittings will be created with freely input angles and 

their detection can be changed in the project options,  Fig. 4 
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 Fitting properties window 

Parameters control group 

Connect with angle fitting – the connection is created at the fitting angle as provided on the side.  

Fitting shape – the angle at which the connection and the main angle (elbow, three-way or four-way 

fitting) are made. 

Below is a window where you can select which set of fittings the user wants to place in a particular 

location. The sets are connected so as to use all the options of executing a connection. The set with a 

reduction fitting or with a fitting and a reduction is selected by default. This setting can be change in 

the Project options  Fig. 7 

Fittings from the sets are automatically published and counted in the Material specification 

generated (9). 
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6 CALCULATIONS AND INTERPRETATION OF 

RESULTS 
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6.1 VERIFYING THE VALIDITY OF A DRAWN INSTALLATION 

Once drawing the installation is done and all the pipelines and items have been connected, you may 

verify the validity of the design in the scope of pipeline connections and other items introduced into 

the project. The verification feature for the installation is activated by clicking the following icon in 

the software toolbar: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_VER 

Next, the "Please select the starting item" command will appear in the ArCADia-Start toolbar at the 

bottom of your screen. The user can for example select the line outflow point. 

The table contains information concerning the number of discontinuities in the installation. The 
software automatically identifies items of the installation that have not been connected and pipeline 
sections that do not have a connection with an outflow point or a fixture outflow. 

After clicking the error information, the user will activate the drawing error detection feature. The 
software will highlight the routes and items where errors occur. The designer can correct the drawing 
by connecting items in order to ensure continuity of the installation. 

After the corrections are implemented, the software will prepare a report informing the user about 
the validity of the designed installation. 

 

In the left part of the window the user may filter errors and display only the selected descriptions. 

The user may select the outflow point in the Installation drop-down list. 

The user may limit the range of errors displayed for a particular level in the Placement drop-down 
list. 

The Items drop-down list gives the user the possibility to choose one of the several item groups that 
were not connected. If there are connection errors in the fittings and inspection opening groups, the 
user may select e.g. only the inspection opening. 

From the Category drop-down list the user selects the error type that occurs in the project: 
unconnected items, faulty connection etc. 

After selecting from the drop-down lists the user can select the items that are not connected and 
that have been assigned to a particular grouping in the drawing. To do that, press the Show selected 
button. The installation projection view field will then be moved to the particular part of the 
installation drawing that includes the group of connection items and will mark it with dotted lines 
with a view of the handles.  
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 Table – Sewage installation report containing information about the validity of the 
designed installation 

Message types (message icons differ): 

 Information  

 Warning  

 Error  

 

Message content – Interpretation 

1. The installation design is correct 

The message appears when there is a connection point present in the installation and all the 
items are directly and indirectly connected to that point, creating an installation that is 
correctly designed in terms of connections. 

2. No outflow point 

This message appears when there is no outflow point in a project. 

3. Unconnected pipeline 

The message appears when there is an unconnected pipeline in the project.  

4. Unconnected items: e.g fittings 

The message appears when an item is not connected to any pipeline. 

5. Items that are not connected to any route: e.g. sewage pipe 

The message appears when an item (also a pipeline) is not directly or indirectly connected to 
a connection point (can be connected to pipelines, although these pipelines will not be 
connected to a connection point). 
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6.2 CALCULATIONS 

After verifying the validity of the installation model created and preliminarily selecting the diameters 

you can carry out calculations by pressing the following icon in the software toolbar: 

The ArCADia software: 

 The Sewage ribbon  Sewage installations logical group   – for determining the 

Horizontal outlet pipe diameters 

or 

 Sewage ribbon  Sewage installations  logical group  – for selecting stack diameters 

AutoCAD or ArCADia-INTELLICAD software:  

 The Sewage installations   toolbar or input ISWR_DETER – for determining the 

Horizontal outlet pipe diameters 

or 

 Sewage installations  toolbar or type ISWR_CALC to determine stacks diameters 

After pressing it, the software will display a window containing two calculation tables. 

 

 Horizontal outlet pipeline calculation table view 
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 Editing diameters in the outlet pipelines calculation table 

 

 Stack calculation table view 

 

Editing diameters in the stacks calculation table is similar as in the case of the outlet pipelines 
calculation table. 

After pressing the Standard button, the user gains access to the tables that are used for calculations 

relating to the stacks. 
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 Standard selection window in the stacks calculation table 
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7 LONGITUDINAL PROFILE OF THE 

INSTALLATION SECTIONS 
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A profile of the correctly drawn installation section can be created by clicking the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

and for creating and organizing profiles the icon sewage ribbon  Sewage installations  logical 

group  

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_PV 

and for creating and organizing profiles the icon: Sewage installations   toolbar 

or input ISWR_PVC 

After pressing one of them in the IntelliCAD software command bar. AutoCAD and ArCADia-START  
a window will appear (in the bottom of the screen) with the following message: "Please select the 
starting item". 

After selecting the starting item (outflow point for the entire installation) the calculation path 

selection window will appear. 

In this window the user selects the main profile path 

 

 Main profile path selection window 

 

After selecting the profile route, the user should select the profile insertion point on the model. 

While the "Sewage installation profile" view is active, the user can activate the modification window 

by clicking the profile frame.  
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 Profile modification window 

A profile properties defining window is displayed after selecting the  or double-clicking the 

profile frame. 

 

 Sewage installation profile properties window 

Appearance control group 

X scale and Y scale – The user can use a drop-down list to select the scale in which the installation 

profile is to be drawn 

Parameters control group. 

Comparative level – The user can enter the profile comparative level. When the option 

Automatically is selected, the comparative level is set at a level lower by 5 m than the lowest point of 

the sewage system. 

Collision configurator button – after clicking this button the user gains access to a collision 

configuration window, where there are two windows in which he can select the items of the ArCADia 
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system that will be included in collision verification. This setting can be saved as a Type in the project 

library (Template). 

 

 Collision configurator window 

The user may use the drop-down list located in the bottom of the window, where they choose if they 

want to verify for Collisions, Crossovers or Collisions and crossovers. 

Upon approval with the OK button, the colliding items will be visible in the profile. 
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8 SEWAGE INSTALLATION EXTENSION 
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An extension of a correctly built sewage installation can be obtained by clicking the: 

Entire installation 

The ArCADia software: Sewage ribbon  Sewage installations  logical group  

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_AVA 

Installation branches 

The ArCADia software: Sewage ribbon  Sewage installations  logical group  

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_AVB 

 

If the user wants to change the properties of the extension view, he can click the extension frame 

and then he will gain access to the extensions properties window. 

 

 Extension properties window 

Offset designations – the user selects one of the two offset insertion possibilities for the 
extension: these can be reference lines or reference symbols and an update all checkbox. Once 
the check box is ticked, all the offsets introduced into the extension will change their reference 
markings and the subsequently introduced ones will already be those selected from the list. 
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9 REPORTS AND LISTS 
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It is possible to obtain a calculation report for a correctly designed installation  

The RTF report button is located in the bottom part of the calculation tables. After pressing it the 
software will display a Save report window. 

 

 Saving calculation report window 

 

The software can generate material lists and a sewage installation item list. 

For the Sewer installation material list 

Clink the icon: 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_SLI 

or 

For the Sewer installation item list 

The ArCADia software: Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software: Sewage installations   toolbar 

or input ISWR_IL 

It is then possible to insert into the drawing a table with a list or material list for all the elements in 
the project. 
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If the user wants to insert an element list or list covering only some elements, e.g. for a single room, 
then: 

in order to input a Selected elements material list for the sanitary installation, click the icon: 

ArCADia software:Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software:Sewage installations toolbar   (or type ISWR_SLSI), 

select items on the projection and confirm by pressing Enter 

or 

in order to input the Selected elements list for the sanitary installation, click the icon: 

ArCADia software:Sewage ribbon  Sewage installations logical group   

AutoCAD or ArCADia-INTELLICAD software:Sewage installations toolbar  (or type ISWR_SIL). 

Clicking table lines or going to Properties allows the user to edit the table content. After clicking the 

 button you can also generate RTF reports. After clicking the  button you can export the data 
from a material list to Ceninwest. 

 

 

 Sewage installation Material specification modification window 

 

 Sewage installation items list modification window 

 

Once a sewage installation item list or a sewage installation material list is inserted and once you 

select the  button or double-click the list frame, a list properties defining window is displayed 

for the items (Fig. 82) and materials (Fig. 83) respectively. 

The appearance and content of the table can be modified by adding or deleting columns 

(components) in the properties window. 
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 Sewage installation items list properties window 
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 Sewage installation Material list properties window 

 

A Material list or an Item list may be selected after inserting – in such a case a modification window 

becomes available with the icon  Marking selected elements on the projection. After clicking on a 

given icon the user may define the position in the list using the mouse. The highlighted table row can 

be clicked and all the elements from this row will be selected on the projection. 

In order to change properties for all selected elements, e.g. type parameters (diameter, 

manufacturer, connection type or other parameters), you must click the icon Change properties of 

selected elements. 
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 Settings view with selected elements 

 


